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До начала эксплуатации внимательно прочитать Руководство для ознакомления с продукцией. 
Запрещается осуществлять монтаж и ввод в эксплуатацию без предварительного прочтения и 
понимания данной публикации. Необходимо хранить руководство в легкодоступном месте, 
чтобы, в случае необходимости, можно было легко найти необходимую информацию. 

1.1  Цель данного руководства по эксплуатации 
Данное руководство представляет собой помощь при монтаже и эксплуатации оборудования 
и обеспечивает поддержку техническому персоналу во всех вопросах по проведению 
эксплуатации и обслуживания. Также, Руководство предназначено для обеспечения 
безопасности жизни и здоровья как пользователей, так и третьих лиц. 

1.2  Адресат данного руководства по эксплуатации 
Руководство предназначено для персонала, проводящего пусконаладочные работы, 
эксплуатацию, техническое обслуживание и ремонт газовых двигателей. Для этого необходим 
определенный уровень знаний принципов эксплуатации газовых двигателей и базовые 
навыки по работе с электронной системой зажигания. Лица, допущенные к работе с газовым 
двигателем, должны пройти обучение у Компании и получить необходимые инструкции, 
касающиеся возможных рисков. 

1.3  Использованные символы и обозначения 
В руководстве используются следующие символы, которые означают: 

Пример  

   

Примечание 

   

Предупреждение  

   

1 ОБЩАЯ ИНФОРМАЦИЯ

Данный символ указывает на примеры, которые демонстрируют 
необходимые действия и оборудование. Также, в примерах дается 
дополнительная информация по данному вопросу. 

Данный символ указывает на важную информацию для оператора, 
обязательную к ознакомлению. Дополнительно, данный символ может 
использоваться для обзора, при описании действий, необходимых к 
исполнению. 

Символ указывает на предупреждение о возможном риске или опасности 
причинения вреда здоровью. Внимательно ознакомиться с примечанием и 
соблюдать меры предосторожности.
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Опасно 

  

1.4  Сокращения и акронимы
В данном руководстве используются следующие сокращения/акронимы. 

Сокр. Термин Описание Пояснение 

CAN bus Controller Area 
Network Bus 

Шина для упраления
устройств/сети

Асинхронная серийная система
подключения для устройств
управления сетью

CE Conformité 
Européenne 

Документы, 
соответствующие 
директивам ЕС 

Отметки на некоторых изделиях 

согласно законодательству ЕС с 

указанием безопасностью продукции 

CPU Central Processing 
Unit 

DC Direct Current  
EMC Electromagnetic

Compatibility 

ESD Electrostatic 
Discharge 

LED Light Emitting Diode Полупроводниковый
светоизлучающий диод

MICT MOTORTECH 
Integrated Con-
figuration Tool 

Настройка программного 
обеспечения для блоков 
управления  MOTORTECH

USB Universal Serial Bus

  

Символ предупреждает о наличии угрозе жизни из-за высокого 
напряжения. Внимательно ознакомиться с примечанием и соблюдать меры 
предосторожности.

Соответствие электрического и 
электронного оборудования 
месту их применения 

Серийная система для 
подключения компьютера к 
внешнему оборудованию
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2.1  Общие инструкции по технике безопасности
Оборудование MOTORTECH произведено согласно новейшим технологиям, является безопасным и
надежным в работе. Тем не менее, при невыполнении следующих инструкций, оборудование
может нанести урон и ущерб здоровью:

– Только квалифицированный и обученный персонал допускается к работе с газовым двигателем.

– Эксплуатация оборудования допускается только в соответствии с его техническими данными.

– Эксплуатация двигателя допускается только согласно его целевому использованию.

– Запрещается применение силы.
– При проведении таких работ, как монтаж, преобразование, переоборудование, техническое

обслуживание и ремонт, необходимо отключить оборудование от сети питания и убедиться,
что не может произойти внезапной подачи питания.

– При проведении работ по техническому обслуживанию и ремонту использовать Руководство и 
эксплуатации и следовать приведенным инструкциям. При проведении технического обслуживания
рекомендуется использование только запасных частей, поставляемых MOTORTECH. Прочие
работы должны выполняться только авторизированными лицами компании MOTORTECH. При
несоблюдении инструкций происходит утрата гарантии и действия сертификата на оборудование.

– Запрещается демонтировать устройства, предназначенные для обеспечения безопасности.

– Следует избегать любых действий, которые могут привести к поломке оборудования.

– Оборудование допускается к эксплуатации только при нахождении в надлежащем состоянии.

– Проверить газовый двигатель или систему зажигания на наличие изменений в процессе 
работы.

– Следует убедиться в соответствии оборудования всем соответствующим директивам и нормам,
включая те, которые не были указаны в данном разделе.

– Если система не достаточно герметична, возможен выпуск газа, что приведет к взрыву. По 
завершению всех работ по сборке, необходимо проверить герметичность системы.

– Необходимо обеспечить достаточное проветривание машинного отделения.

– Рекомендуется убедиться в безопасном расположении газового двигателя.

2 ИНСТРУКЦИИ ПО ТЕХНИКЕ БЕЗОПАСНОСТИ
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2.2  Возможная опасность электростатического разряда 
Электронное оборудование является чувствительным к статическому электричеству. Для
уменьшения последствий и предотвращения повреждений от разряда, рекомендуется
соблюдать приведенные инструкции. 

При работе с двигателем или при нахождении в непосредственной близости с оборудованием,
соблюдать следующие правила.

– До начала проведения работ по техническому обслуживанию и ремонту, убедиться в 
отсутствии статического электричества на одежде. 

– Для предотвращения скапливания статического электричества, не рекомендуется носить 
одежду из синтетических материалов. Следует носить хлопковую одежду или вещи с
содержанием хлопка. 

– Пластиковые материалы, такие как винил или пенополистерол, следует хранить в дали от 
системы управления, модулей и рабочей среды. 

– Запрещается снимать монтажные платы с корпуса устройства. 

2.3  Особые инструкции по обеспечению безопасности устройства 
  

Риск возникновения взрыва  

   

Риск возникновения взрыва 

   

Безопасность при эксплуатации устройства

Все болты коннекторов должны быть затянуты надлежащим образом. 

   

Во время работы системы запрещается демонтировать коннекторы, до
обеспечения безопасной окружающей среды около системы.

В случае недостаточной герметизации системы, может произойти утечка
газа, что приведет к возникновению взрыва. После завершения всех работ
по монтажу, необходимо убедиться в надлежащей герметизации системы.
Убедиться, что контрольное отверстие на VariFuel2 закрыто. 
Все работы на основных газовых элементах должны осуществляться только
квалифицированным персоналом. 
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Риск возникновения неисправностей из-за электростатического разряда

   

Риск получения ожогов 

Поверхности системы нагреваются до высоких температур.

   

Риск повреждений

  

2.4 Надлежащая утилизация
После окончания срока службы, оборудование MOTORTECH должно быть утилизировано как 
бытовые отходы или его следует сдать в MOTORTECH. Таким образом, Компания сможет 
произвести надлежащую утилизацию продукции.

Плата шагового двигателя VariStep устанавливается только теми 
специалистами, которые прошли обучение по эксплуатации компонентов 
ESD согласно стандартам ESD. Плата устанавливается внутри шкафа 
управления и должна соответствовать ESD стандартам DIN EN 61340-5-1; 
VDE 0300-5-1:2008-07.
Гарантия не покрывает неисправности, произошедшие в результате
электростатического разряда.

Шаговый двигатель VariFuel2 не подходит для поддержания или подъема 
газового смесителя. Существует опасность поломки шагового двигателя, а 
неисправность газового смесителя может привести к нанесению травм и 
порче имущества.
Всегда переносить или поднимать газовый смеситель за внешний корпус.
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3.1  Описание эксплуатации
Плата шагового двигателя VariStep управляет шаговым двигателем газового смесителя
VariFuel2. Такой шаговый двигатель изменяет отверстия топливного кольца, изменяя, таким 
образом, состав газо-воздушной смеси.

Возможен выбор ручного и автоматического управления. Ручные настройки вводятся при 
помощи кнопок на плате шагового двигателя через подключение к ПК. В автоматическом 
режиме, происходит анализ сигналов цифровых и аналоговых входов, предоставляемых
главным управлением.

Плата шагового двигателя настраивается при подключении к ПК. Программное обеспечение, 
используемое для данной цели, также используется для отображения текущих данных системы 
и сообщений об ошибках.

3.2  Применение
Плата шагового двигателя VariStep может использоваться для всех газовых смесителейVariFuel2
с шаговыми двигателями. Если используются два газовых смесителя VariFuel2, необходимы две 
платы шагового двигателя VariStep. Дополнительный распределитель не требуется.

Любое другое использование, которое не было описано выше, считается нецелевым и влечет 
утрату гарантии.

3 ЦЕЛЕВОЕ ИСПОЛЬЗОВАНИЕ
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4.1  Технические характеристики 

4.1.1 Сертификация 
Плата шагового двигателя сертифицирована согласно следующим стандартам:

CE 
– Директива EMC 2004/108/EC 

– Стандарт на излучение для излучающей среды промышленных предприятий
DIN EN 61000-6-4:2007 

– Реакция на промышленную среду согласно DIN EN 61000-6-2:2006 

4ОПИСАНИЕ ПРОДУКЦИИ
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ДЕКЛАРАЦИЯ О СООТВЕТСТВИИ

Компания: MOTORTECH GmbH
Hogrevestrasse 21-23
29223 Celle 

заявляет, что ее продукция: Плата шагового двигателя VariStep

назначение: использованиие с газовым двигателем Отто 

соответствует всем техническим характеристикам, согласно директивам ЕС : 

EMC Directive 2004/108/EC

с учетом следующих применимых стандартов:

DIN EN 61000-6-4:2007
DIN EN 61000-6-2:2006 
DIN EN 61000-4-2, DIN EN 61000-4-3
DIN EN 61000-4-4, DIN EN 61000-4-5 
DIN EN 61000-4-6, DIN EN 61000-4-8 

маркировка продукции:
P/N 31.01.955

Декларация выдана:

ФИО: Флориан Вирчов  Должность: Генеральный директор 

  

  

  

Целле, 16.02.2011 

Город, дата
подпись уполномоченного лица
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4.1.2 Механические характеристики
Плата шагового двигателя обладает следующими механическими характеристиками:

Свойство Значение 

Габариты 217 x 128 x 50 мм (8.54 x 5.04 x 1.97 '')

(длина x ширина x высота) 

Вес 655 г (1.44 lbs)

Форма устройства См. раздел Обзор схем на странице 18

Механические условия 
окружающей среды

Степень защиты: IP20

Климатические условия
окружающей среды 

макс. от -15 °C до 65 °C (от 5 °F до 149 °F)

Макс. 85% влажности без конденсата
до 2000 м (6561.68 ') выше уровня моря

4.1.3 Предупреждающие символы на устройстве

Верхняя часть устройства

Предупреждение Значение 

Возможно воздействие 
электростатического разряда.

ПРЕДУПРЕЖДЕНИЕ: Внимательно 
ознакомиться с Руководством по 
Эксплуатации до осуществления монтажа и 
настроек. Не допускается отключение 
оборудования, пока питание включено.
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4.1.4 Идентификация продукции – Маркировка устройства
Номера, необходимые для идентификации продукции, указаны на шильде устройства:

Верхняя часть устройства

Нижняя часть устройства

Сокр. Значение 

P/N Номер продукции блока управления

S/N Серийный номер блока управления



4 ОПИСАНИЕ ПРОДУКЦИИ

16 Ред. 07/2013 

4.1.5 Данные по электрической части 
Плата шагового двигателя обладает следующими электрическими характеристиками:

Параметр Значение 

Расход питания Макс. 31 Вт

Питание от 18 до 32 В постоянного тока

Необход. ток Макс. 1.7 A

Внутр. предохранитель 3.15 A, задержка, 5x20 мм, заменяемый

Эдектрические данные по входам и выходам
Входы и выходы плата шагового двигателя обладают следующими электрическими данными:

Входы и выходы Значения/характеристики

Цифровые входы – Гальванически изолированы

– Напряжение входа до 32 В постоянного тока

– Ток входа мин. 5 мA для высокого уровня

– Безопасный нижний уровень:  
напряжение ниже 1.0 В DC мин. на 30 μс

– Безопасный верхний уровень:
напряжением выше 4.5 В DC мин. на 5 μс

Схема сигнала

При подаче сигнала сброса, высокий уровень должен быть на 
соответствующем входе на мин. 50 мс до того, как станет 
возможно начать сброс.
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Входы и выходы Значения/характеристики

Цифровые входы – Гальванически изолированы

– Нижний уровень: выход - больше сопротивление

– Верхний уровень: выход - низкое сопротивление

– Коммутационное напряжение: макс. 32 В 

– Ток: максимум 500 мA 

Аналоговый вход 
напряжения (Uin)

Допустимое напряжение: от 0 до 10 В

Сопротивление входа: 12.4 kΩ 

Аналоговый вход тока
(Iin)

Допустимый ток: от 0 до 20 мA

Макс. разница в потенциале относительно заземления: +/-15 В  

Сопротивление входа: 10 Ω 

Аналоговый выход 
напряжения (Uout) 

Напряжение выхода: от 0 до 10 В

Рабочее сопротивление: мин. 300 Ω 

Аналоговый выход 
тока (Iout) 

Ток выхода: от 0 до 20 мA 

Рабочее сопротивление: макс. 300 Ω 

4.1.6 Интерфейсы 
USB 

– Совместимость с USB 1.1 и USB 2.0

– Коннектор версии В подходит только для временного обмена данными и не 
допустим для постоянного подключения.

Шина CAN 2.0B интерфейс (ток не применяется)
– Согласно ISO 11898, до 1 МБит/с

– С защитой от перехода (автоматическая классификация)

– Макс. 110 проводников

Интерфейс Modbus (ток не применяется)
– Стандарт RS485

– Макс. 32 проводников

– Полный дуплекс (4-полюса) или полудуплекса (2-полюса)
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4.1.7 Обзор чертежей 
Порты/Подключения и светодиоды

Описание Функция 

Digital Inputs Цифровые входы, по которым возможно изменение отверстия 
топливного кольца. Также доступен цифровой вход для сигнала
сброса (см. Подключение цифровых входов на странице 24). 

Digital Outputs Цифровые выходы, которые показывают положение шагового 
двигателя и статус платы шагового двигателя (см. Подключение 
цифровых выходов на странице 25). 

Analog 
Inputs/Outputs 

Аналоговые входы и выходы, которые используются для изменения 
или возврата положения шагового двигателя (см. Подключение 
аналоговых входов и выходов на странице 26). 

USB Порт для передачи данных на ПК. Передача данных указывается 
горящими светодиодами TXD и RXD (TXD=передаваемые данные, 
RXD=получаемые данные). 

CAN 
(не доступен) 

Порт для коммуникации по шине CAN с главным устройством 
управления (например, ALL-IN-ONE). Передача данных указывается 
при помощи горящих светодиодов TXD и RXD (TXD=передаваемые 
данные, RXD=получаемые данные). 
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Описание Функция 

Modbus (RS485) 
(не доступен) 

Порт для коммуникации по Modbus с главных устройств управления.
Передача данных указывается при помощи горящих светодиодов
TXD и RXD (TXD=передаваемые данные, RXD=получаемые данные). 

Open/Close; 
Reset 

Кнопки Open и Close могут использоваться для управления шаговым 
двигателем в ручном режиме (см. Ручное и автоматическое управление
на стр. 31). В случае неисправности, ошибку можно сбросить при 
помощи нулевой точки при одновременном нажатии обеих кнопок.

Auto/Manual Переключатель для перехода между ручным и автоматическим 
режимом (см. Ручное и автоматическое управление на стр. 31).

Status LEDs – Power
Горящий светодиод указывает на достаточное напряжение.

– Status 
Светодиод горит зеленым светом, если плата шагового двигателя 
работает без сбоев. При возникновении ошибки, светодиод горит 
оранжевым (см. Runtime Data – Неисправности на стр. 59). 

– Auto 
Светодиод загорается, если плата шагового двигателя находится 
в автоматическом режиме и управляется сигналами с главного 
поста управления.

– Manual 
Светодиод горит при работе платы шагового двигателя в ручном 
режиме.

Power IN 

Stepper Motor + 
Encoder 

Fuse Заменяемый предохранитель (3.15 A)

Подключение подачи напряжения (см. Подключение питания на 
странице 21).

Порт для шагового двигателя и кодировщика. Светодиод Motor
Activity мигает, когда шаговый двигатель работает (см. 
Подключение шагового двигателя и кодировщика на странице 22)
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5.1  Инструкции по монтажу
Осторожно снять упаковку с шагового двигателя и обеспечить легкий и быстрый доступ к 
Руководству по эксплуатации. Не допускается монтаж в зоне сильных вибраций или при 
температуре окружающего воздуха ниже -15 °C (5 °F) или выше 65 °C (149 °F), поскольку это 
приведет к утрате гарантии.

Риск повреждений

   

Риск повреждений

   

Риск поломок из-за электростатического разряда

  

Комплект поставки
Плата шагового двигателя VariStep поставляется в следующей комплектации:

– Плата шагового двигателя VariStep

– Оптический привод CD-ROM

– Кабель USB

– Руководство по эксплуатации

Монтаж блока управления
1. Установить блок управления на рейку DIN в шкафу управления.

2. Закрепить плату при помощи крепежных винтов по бокам устройства.

5ИНСТРУКЦИИ ПО МОНТАЖУ

Плата шагового двигателя VariStep устанавливается только персоналом, 
который прошел обучение по эксплуатации компонентов ESD согласно 
стандартам ESD. Плата устанавливается внутри шкафа управления и должна 
соответствовать ESD стандартам DIN EN 61340-5-1; VDE 0300-5-1:2008-07.
Гарантия не покрывает неисправности, произошедшие в результате 
электростатического разряда.

Не допускается монтаж устройства прямо на двигатель, поскольку 
вибрации и излучаемое тепло могут нанести урон электронным 
компонентам.

Убедиться, что устройство не накрыто посторонними элементами, и 
обеспечить достаточную циркуляцию воздуха.
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6.1  Подключение подачи питания
Питание подключается при помощи трехполюсного штепселя.

Варианты 

1 Аккумулятор Генератор Блок управления

2 Подача напрядения

3 Аккумулятор Зарядное устройство

6 ПОДКЛЮЧЕНИЕ БЛОКА УПРАВЛЕНИЯ
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6.2  Подключение шагового двигателя и кодировщика 
Подключение по 11-полюсному штепселю на плате шагового двигателя. Длина 
соединительного кабеля не должна превышать 10 м (32.8 футов).

Кодировщик 

Шаговый двигатель
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Распределение пинов при использовании оригинальной электропроводки MOTORTECH: 

Пины на плате
шагового двигателя

Описание 
Пины на шаговом
двигателе и
кодировщике 

Цвет провода/
назначение 

1 Заземление кодировщика J Коричневый

2 Кодировщик
напряжение 5 В

I Желтый

3 Кодировщик A E Белый

4 Кодировщик B F Зеленый

5 Кодировщик I (указатель) G Серый

6 Заземление кодировщика H Экран

7 Фаза шагового двигателя B2 D 4

8 Фаза шагового двигателя B1 C 3

9 Земля шагового двигателя H Экран

10 Фаза шагового двигателя A2 B 2

11 Фаза шагового двигателя A1 A 1
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6.3  Подключение цифровых входов
Цифровые входы подключаются через 10-полюсный штепсель. Входы переключаются со 
стороны рабочего напряжения и заземления.

L  5 – 32 V DC 

Пин Назначение Функция 

1 DIRin + Уровень на цифровом входе указывает, в каком направлении 
происходит движение топливного кольца, если на входе STEPSin
есть импульсные сигналы (см. Входы/Выходы - Настройка 
управления  на стр. 48). 

2 DIRin - 

3 STEPSin + Импульсные сигналы на входе постепенно перемещают 
топливное кольцо (см. Входы/Выходы - Настройка управления на 
стр. 48). 

4 STEPSin - 

5 POS1in + 

6 POS1in - 

7 POS2in + При применении высокого уровня, приближается положение 2, 
указанное в настройках.8 POS2in - 

9 RESETin + 

10 RESETin - 

При применении высокого уровня, приближается положение 1, 
указанное в настройках.

При использовании высокого уровня мин. на 50 мс, устройство 
выходит из режима неисправности, и плата шагового двигателя 
производит сброс. Соответственно, происходит установка 
нулевой точки.
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6.4  Подключение цифровых выходов
Цифровые входы подключаются при помощи 12-полюсного штепселя. Выходы переключают
рабочее напряжение и заземление.

L  5 – 32 V DC, max. 500 mA 

Пин Назначение Функция 

11 ERRORout + 

12 ERRORout - 

13 CLOSEout + Выход будет низкого сопротивления, если шаговый 
двигатель достиг закрытого положения. 14 CLOSEout - 

15 OPENout + 

16 OPENout - 

17 POS1out + Выход будет низкого сопротивления, если шаговый 
двигатель достиг настроенного положения 1.18 POS1out - 

Выход - низкого сопротивления, если произошла неисправность и 
плата шагового двигателя находится в автоматическом режиме. 
Для выхода из состояния ошибки, неисправность необходимо 
подтвердить (см. Подтверждение неисправностей на странице 
71).

Выход будет низкого сопротивления, если шаговый двигатель 
достиг открытого положения.
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Пин Назначение Функция 

19 POS2out + 

20 POS2out - 

21 OFFLINEout + Выход будет низкого сопротивления, если плата шагового 
двигателя находится в состоянии, в котором она не реагирует на 
внешние сигналы управления (пример, ручной режим или 
нулевая точка).

22 OFFLINEout - 

6.5  Подключение аналоговых входов и выходов
Аналоговые входы и выходы подключаются при помощи 14-полюсного штепселя.

Выход будет низкого сопротивления, если шаговый двигатель 
достиг настроенного положения 2.
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Пин Назначение Функция 

23 Uin + 

24 Uin GND 

25 Iin + Вход тока, по которому происходит настройка топливного 
кольца (см. Входы/Выходы - Настройка управления на стр. 48).26 Iin - 

27 PWMin + Не используется для VariFuel2.

28 PWMin - 

29 Uout + У выхода напряжения и тока общее заземление. Выходы 
подают положение тока топливного кольца в виде 
соответствующего сигнала.

30 Uout/Iout GND 

31 Iout + 

32 Spring + Не используется для VariFuel2.

33 Spring - 

34 PickUp + Не используется для VariFuel2.

35 PickUp - 

36 PickUp Pwr 

  

Неиспользуемые входы и выходы

  

Вход напряжения, через который настраивается топливное 
кольцо (см. Входы/Выходы - Настройка управления на стр. 48).

Стоит отметить, что клеммы аналоговых входов и выходов, не выбранных в
MICT, должны оставаться свободными.



6 ПОДКЛЮЧЕНИЕ БЛОКА УПРАВЛЕНИЯ

28 Ред. 07/2013 

6.6  Подключение шины CAN
Интерфейс шины CAN 2.0B недоступен в настоящий момент.

Интерфейс шины CAN подключается при помощи 4-полюсного штепселя.

Second-to-last device

   Second device Last device

  

Подключение шины CAN

Учитывать следующее при подключении шины CAN:

– К одной шине CAN возможно подключение до 110 устройств.

– Максимальная длина кабеля составляет 250 м (820 футов) в зависимости

– На каждом конце шины должен быть клеммный резистор 120 Ω 

  

First device

скорости передачи.

(как указано на схеме).
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6.7  Подключение Modbus 
Интерфейс Modbus в настоящее время не доступен.

Modbus может быть подключен при помощи полудуплекса или полного дуплекса, с
использованием витой пары. В обеих моделях, сопротивление нагрузки RT соответствует
волновому сопротивлению кабеля. 

Подключение полудуплекса 
First device   Last device

Second device Second-to-last device

Подключение полного дуплекса

Master
  Last slave

First slave Second-to-last slave
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Порт на плате шагового двигателя
Modbus подключается при помощи 6-полюсного штепселя.
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7.1  Эксплуатация в ручном и автоматическом режиме
Возможна настройка двух режимов для отверстия в топливном кольце настраивается при 
помощи платы шагового двигателя:

– ручной (Manual) режим

– автоматический (Auto) режим

Переключение от ручного режима к автоматическому производится при помощи переключателя
Auto/Manual  или через MICT. В этом случае, MICT переписывает положение переключения 
устройства. Возможна блокировка переключателя Auto/Manual путем внесения соответствующих 
настроек в MICT. Горящий светодиод статуса Manual или Auto указывает на режим, который 
активен на плате шагового двигателя в настоящий момент.

Ручной режим работы
В ручном режиме работы, внешние сигналы входа основного управления не учитываются. 
Отверстия топливного кольца могут открываться или закрываться при помощи кнопок Open и
Close  или через MICT. Для настройки MICT и передачи данных настроек устройству необходимо 
установить ручной режим работы платы шагового двигателя.

Риск повреждений

  

Автоматический режим работы
В автоматическом режиме работы, плата шагового двигателя оценивает внешние сигналы входа 
подключенного блока управления. Кнопки Open и Close не работают при настройке отверстий. 
Устройство не может быть настроено через MICT. В автоматическом режиме работы, MICT
используется только для отображения данных и для создания журналов регистрации.

7.2  Нулевая точка
После включения или перезагрузки устройства, плата шагового двигателя устанавливает 
нулевую точку. Это означает, что шаговый двигатель постепенно приближается к положению, 
настроенному главным управлением. В ручном режиме работы, топливное кольцо остается 
полностью открытым (сначала).

Во время процесса определения нулевой точки, сопротивление входа OFFLINEout низкое и 
соответствует горящему светодиоду. Анализ сигналов входа не производится.

7 ФУНКЦИИ 

В ручном режиме работы не происходит анализ сигналов основного 
управления. При введении каких-либо настроек в ручной режим работы 
при работающем газовом двигателе, убедиться, что такие настройки не 
будут влиять на работоспособность газового двигателя.
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7.3  Положения Open/Closed 
Открытое и закрытое положение характеризуется следующим: 

– Open: Полностью открытое отверстие топливного кольца (открыто на 100%) 

– Closed: Полностью закрытое отверстие топливного кольца (открыто на 0%)

При достижении одного из двух положений, включается соответствующий цифровой выход
OPENout или CLOSEout , и соответствующий светодиод загорается. Топливное кольцо не 
может выходить за рамки двух положений, все соответствующие сигналы будут отклонены.

7.4  Настраиваемые углы открытия (Положения 1 и 2)
MICT может использоваться для настройки двух углов открытия топливного кольца, а отверстия 
могут управляться напрямую по цифровым входам (POS1in, POS2in). Если сигналы POS1in и
POS2in одновременно присутствуют, произойдет приближение к положению 1. Если шаговый 
двигатель достигает одно из двух положений, включается соответствующий цифровой выход
(POS1out, POS2out), и загорается соответствующий светодиод. В этом случае, можно определить 
углы отверстия для определенных рабочих состояний, таких как запуск или продувка газового 
двигателя.

Настройка положений 1 и 2 достигается через MICT. Для получения более подробной 
информации, см. раздел Положения - Значения на странице 51. 

7.5  Изменение отверстия через цифровой и аналоговый входы
В автоматическом режиме, отверстия топливного кольца могут управляться напрямую при 
использовании следующих входов:

– Цифровые входы DIRin и STEPSin 

– Аналоговый вход напряжения Uin 

– Аналоговый вход тока Iin 

В зависимости от использованного главного управления, возможен выбор необходимого входа 
при помощи MICT. При достижении одного из двух конечных положений (Open или Closed), все 
сигналы на входам в соответствующем направлении отклоняются. 

Возможна настройка входов при помощи MICT. Для получения более подробной информации, 
см. раздел Входы/Выходы - Настройка управления на странице 48.

7.6  Анализ положения через аналоговые выходы
Текущее положение топливного кольца отправляется на главное управление по аналоговому 
выходу напряжения или аналоговому выходу тока. При помощи MICT, возможно настроить 
какой из выходов будет использоваться и какое значение напряжения или тока соответствует 
открытому или закрытому положению. Ток и/или напряжение, подаваемое на выход,
пропорционально отверстию топливного кольца.

Настройка выходов возможна с помощью MICT. Для получения более подробной информации, 
см. раздел Входы/Выходы - Настройка управления на странице 48.
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7.7  Управление доступом
Возможно защитить блок управления устройства VariFuel2 от неавторизированного доступа 
путем настройки управления доступа в MICT. Управление доступом осуществляется на 4 
рабочих уровнях, три из которых закреплены за различными ПИНами. По умолчанию, 
управление доступом выключено. Если управление доступом включено, то оно не зависит от 
уровней доступа, которые управляют просмотром данных в пределах MICT. 

Управление доступом

  
На четырех рабочих уровнях существуют различные функции, которые частично представлены 
на схеме ниже:

Пользователь заходит в уровень доступа Advanced Service на MICT. Он 
производит изменение настроек и загружает последнее на блок 
управления. Хотя пользователь имеет полные права в MICT, ему 
необходимо зайти при помощи PIN для Level3 (Master). Это подтверждает, 
что невозможно изменить настройки блока управления только с помощью
MICT и общего пароля.
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Следующие функции доступны на разных уровнях: 

– Level 0 (Read Only)
Доступ “только чтение” для всех пользователей.

– Level 1 (Operator)
На этом уровне, пользователь может менять положения топливного кольца (подход
находится в закрытом и открытом положении, положение 1 и положение 2, производить
замены вручную для открытия). После этого, возможно изменение режима работы и
подтверждение ошибок.

– Level 2 (Service)
Обслуживающий персонал может установить нулевую точку и выполнить сброс
максимального количества потерь шагов в течение всего времени работы.

– Level 3 (Master)
На этом уровне, основная система может произвести сброс всех ПИНов и открыть/закрыть
управление доступом. Также, только основная система имеет право на загрузку
измененных настроек на устройство управления.

Для получения более подробной информации по уровням доступа MICT, см. раздел Уровни
доступа MICT на странице 36.
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8.1  Системные требования MICT
Для установки MICT, необходимо выполнение следующих минимальных требований: 

– x86-совместимость ПК, категория минимального исполнения Intel Pentium 4 с 2 ГГц 

– 128 MB свободного места оперативной памяти 

– 100 MB свободного места на диске 

– Интерфейс совместимый с USB 1.1

– Дисплей с минимальным разрешением XGA (1024 x 786 пикселей) 

– Microsoft Windows XP, Windows 7 

8.2  Установка MICT 
Программное обеспечение для установки MICT записано на CD-ROM, который прилагается к 
блоку управления.

Для установки MICT, необходимо выполнить следующее:  

1. Начало установки. 

– CD-ROM как источник установки
Вставить CD-ROM в оптический привод CD/DVD на ПК. Если функция автозапуска 
включена, установка начнется автоматически. Если данная функция не действительна, 
запустить установку при помощи файла setup.exe напрямую с CD-ROM. 

– Другое 
Скопировать файл установки setup.exe на ПК. Установка начнется при запуске файла.

2. Запуск установки. 
Следовать инструкциям в диалоговом окне. Отметить принятие условий лицензионного
договора, до использования MICT. Установка не может быть продолжена при отказе от 
условий соглашения.

3. Установить драйвер USB путем запуска файла CDMxxxxx_Setup.exe (пр. CDM20824_Setup.exe). 
▸ Система MICT установлена, и теперь можно подключить ПК к блоку управления по 

интерфейсу USB.

8 SETTINGS VIA THE MICT
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8.3  Уровни доступа в MICT
Открыть MICT на ПК при помощи Start -> Programs -> MOTORTECH -> MICT -> MICT.

После открытия MICT, выбрать разрешенный уровень доступа. Уровень доступа управляет
функциями системы MICT. Пароль, необходимый для доступа, отправляется вместе с самим
устройством.

Возможны следующие уровни доступа:

– Read Only
На этом уровне, пользователь может открыть настройки и отправить их на устройство.
Тем не менее, внесение изменений в настройки невозможно. Пользователь обладает
доступом “только чтение” для всех настроек.

– Customer
Данный уровень позволяет производить настройку базовых функций, необходимых для
работы, дополнительно к функции “только чтение”.

– Service
Данный уровень содержит все функции, необходимые для проведения технического
обслуживания.

– Advanced Service
Данный уровень предлагает полный доступ ко всем функциям MICT, находится в
рабочем состоянии и доступен только для специально обученного персонала.

В следующих разделах описаны функции, доступные на уровне Advanced Service. Если
пользователь зарегистрирован на разных уровнях, он не может выполнять все показанные
функции.
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8.4  Страница настроек (Обзор) 
Страница настроек поделена на следующие разделы:

Далее приводится описание функции меню, навигационной панели (navigation bar) и toolbar, 
так же, как и раздел настроек.

На панели состояния (status bar) отображается следующая информация (слева на право):

– Дисплей состояния (Status display)
Указывает на состояние установленного подключения с контроллером: 

– Зеленый: соединение установлено

– Красный: соединение было прервано, но восстанавливается в данный момент

– Серый: соединение не установлено и не восстанавливается 

– Указание интерфейса, используемого для подключения устройства

– Указание ID устройства 

– Указание уровня доступа пользователя системой MICT 

– Указание рабочих часов для VariStep, управление доступом включено, пользователь вошел 
в систему при помощи PIN (ПИН)

– Указание программной версии MICT



8 НАСТРОЙКИ ЧЕРЕЗ MICT

38 Ред. 07/2013 

8.5  Menu Bar и Toolbar 
Следующие функции доступны для пользователя при открытии файлов toolbar и входе в меню
menu bar: 

Символ Меню Функция 

File -> New Создание новых настроек.

File -> Open Открытие уже существующих настроек.

File -> Save / 
File -> Save As 

Сохранение текущих настроек.

File -> Close Закрытие текущих настроек.

File -> Open trace 

File -> Open pickup trace Открыть сохраненные записи сигналов 
датчика (файл трассировки), например, с 
регулятора зажигания MOTORTECH. Сигналы 
датчика не могут записываться с VariStep. 

File -> Change Access Level 

File -> Print Печать текущих настроек.

File -> Print To PDF File Печать настроек в файл PDF.

File -> Print Preview Открыть “предварительный просмотр” 
настроек.

File -> Quit Выход из MICT.

Device -> Connect Подключение устройства.

Device -> Disconnect Отключение соединение с устройством.

Открытие записей по данным рабочего 
времени (файл трассировки). См. раздел 
Runtime Data на странице 55.

Изменение уровня доступа для доступа к 
данным настроек и функциям.
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Символ Меню Функция 

Device -> Download to device Скачать данные настроек с ПК на устройство.
Данная функция может быть выполнена в
ручном режиме.

Device -> Upload from device 

Device -> Runtime data Открыть окно Runtime Data. См. раздел
Runtime Data на странице 55. 

Device -> Log 

Device -> Select Mode Открыть окно Select Mode, где происходит
выбор рабочего режима. Возможны
следующие режимы: Manual Operation Mode,
Automatic Operation Mode или Hardware Con-
trolled Operation Mode. 

Device -> Manual Adjustment 

Device -> Open Position Полностью открыть топливное кольцо в
ручном режиме.

Device -> Close Position 

Device -> Position 1 Открыть топливное кольцо в ручном режиме
согласно проценту, указанному в настройках
для положения 1.

Device -> Position 2 

Device -> Reference Run Осуществление пробного запуска в ручном
режиме (только Service и Advanced Service). 

Device -> Temperature Extremes  

Device -> Error Acknowledge Подтверждение всех рабочих ошибок

Загрузить данные настройки с устройства на
ПК.

Открыть окно Log (только Advanced Service). См.
раздел Log на странице 64.

Открыть окно, в котором производится ручная
настройка угла открытия топливного кольца.

Закрыть отверстие топливного кольца в
ручном режиме.

Открыть топливное кольцо в ручном режиме
согласно проценту, указанному в настройках
для положения 2.

Открыть окно, в котором показана
минимальная и максимальная температура.
Такие значения  измеряются в течение всего
рабочего времени на щите блока управления.
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Символ Меню Функция 

Device -> Access Control 

Device -> Trigger Software Reset Перезапустить рабочее ПО устройства (только
Advanced Service). 

Settings -> Language 

Settings -> Online update settings

Settings -> Temperature scale 

Settings -> Display by cylinders Функция доступна на некоторых регуляторах 
зажигания MOTORTECH и не оказывает никакого 
действия в сочетании с VariStep. 

Document Нет функций с VariStep.

Help -> Help Отрыть он-лайн функцию помощи.

Help -> About MICT Открыть подробную информацию по MICT.

Настройка управления доступом на устройстве
описана в отдельном разделе. Необходимо 
прочитать раздел Управление доступом и 
Блок Управления на странице 42.

Открыть окно Select Language в котором 
происходит изменения языка интерфейса 
системы MICT.

Открыть окно Online Update Settings. См. 
раздел Обновление настроек он-лайн на 
странице 41.

Открыть окно Select Temperature Scale для 
изменения единиц измерения температуры в 
системе MICT.



Ред. 07/2013 41 

8.6 Настройки он-лайн обновления

Система MICT использует данные с базы данных VariFuel для осуществления настроек. Такие 
данные загружаются с автоматических он-лайн обновлений. Настройки обновления 
устанавливаются при помощи следующего входа в menu bar: 
Settings -> Online update settings 

Доступны следующие опции: 

– Enable automatic database updates 
Включение и выключение автоматического он-лайн обновления при помощи диалогового 
окна. Согласно настройкам по умолчанию, он-лайн обновление активируется и выполняется 
ежедневно (если установлено подключение к интернету) при первом запуске системы MICT. 

– Use a proxy to access the web 
При помощи диалогового окна, возможна активация настроек для доступа в интернет 
через прокси-сервер, который настраивается путем ввода http-Proxy и Port. 

– Show Log 
Эта кнопка открывает окно, в котором вводятся осуществляемые он-лайн настройки.

– Update Now 
Данная кнопка используется для запуска ручного он-лайн обновления.

Он-лайн обновление

  

После обновления он-лайн, обновленные данные будут использоваться,
только если они загружены на устройство. Тем не менее, это потребует
соответствующего допуска.
Всякий раз, когда настройки загружаются с устройства, версия настроек, 
сохраненных на устройстве, сравнивается с версией в базе данных. Если 
две версии не совпадают, откроется окно с дополнительными 
инструкциями.
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8.7  Управление доступом Блока управления
Если управление доступом на блоке управления включено, доступ к следующей области 
возможен только через PIN:

– Troubleshooting (Неисправности)

– Position changes (Открыть, Закрыть, Положение 1 и 2, Ручная Настройка (Manual Adjust-
ment), нулевая точка (Reference Run))

– Configuration (передача настроек на блок управления)

Управление доступом регулирует доступ к блоку управления через систему MICT. Пояснения по
функционалу управления доступом блока управления и разграничения уровней доступа в
системе MICT можно найти в разделе Управление Доступом на странице 33. 

Функции управления доступом указаны в меню menu bar через:

Device -> Access Control

8.7.1 Включение/Выключение управления доступом

Включение и выключение управления доступом

Для включения или выключения управления доступом, выполнить следующее:

1. Открыть входящее диалоговое окно через Device -> Access Control -> Enable or 
Disable access control.

2. Ввести PIN для уровня Master (Level 3).
3. Нажать OK для входа.

Согласно настройкам по умолчанию, управление доступом выключено, и
все ПИНЫ установлены на 0000. После активации управления доступом и
изменения всех ПИНов, именно эти ПИНы будут использоваться далее. Для
повторной активации управления доступом, необходим ПИН для level 3
(Master). Рекомендуется произвести сброс всех ПИНов до выключения.

Если это не было сделано, или систему необходимо разблокировать по
другой причине, возможен запрос ключа в системе MICT. См. раздел Сброс
всех ПИНов на странице 44.
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8.7.2 Вход/Выход
Если управление доступом включено, необходимо войти на соответствующий уровень для 
возможности выполнения функций, которые требуют определенного уровня доступа. В 
дополнение, возможен вход в систему на специальный рабочий уровень через menu bar.

Для входа на специальный рабочий уровень, необходимо выполнить следующее:

1. Открыть диалоговое окно Device-> Access Control -> Login.

2. Сначала выбрать уровень,  в который необходимо зайти.

3. Ввести ПИН необходимого уровня.

4. Подтвердить, путем нажатия OK.

▸ Вход на соответствующий уровень был произведен, и пользователь в состоянии 
выполнять все функции, которые доступны на данном уровне без повторного входа в 
систему.

После завершения входа, выход производится следующим образом:

Device -> Access Control -> Logout

8.7.3 Замена PIN (ПИНа)
Для замены ПИНа специального рабочего уровня, необходимо выполнить следующее:

1. Открыть диалоговое окно Device -> Access Control -> Change PIN.

2. Выбрать уровень, на которым необходимо сменить ПИН.

3. Ввести текущий ПИН данного уровня.

4. Ввести новый ПИН в двух последующих полях.

5. Подтвердить, путем нажатия OK.

▸ Замена ПИНа на рабочем уровне выполнена.



8 НАСТРОЙКИ ЧЕРЕЗ СИСТЕМУ MICT 

44 Ред. 07/2013 

8.7.4 Сброс всех ПИНов

Для сброса всех ПИНов необходимо выполнить следующее:

1. Открыть диалоговое окно через Device -> Access Control -> Reset all PINs.

2. Если пользователь еще не зашел в уровень Master (level 3) , необходимо войти в систему, 
введя соответствующий ПИН.

3. Подтвердить ввод при помощи OK.

4. Для сброса всех ПИНов, необходимо снова ввести ПИН для уровня Master (level 3).
5. Подтвердить ввод при помощи OK.

▸ Теперь все ПИНы установлены на 0000.

Для сброса всех ПИНов, необходим ПИН уровня Master (level 3). Чтобы разблокировать систему, 
которая блокируется в случае аварийной ситуации, необходимо выполнить следующее:

1. В меню menu bar, выбрать Device -> Access Control -> Get reset all PINs request key
для открытия окна с таким же именем.

2. Отправить запрашиваемый ключ с серийным номером в Отдел Сервисного обслуживания
MOTORTECH (см.  Информация по сервисному обслуживанию на странице 71). Этот ключ 
действителен только для соответствующего регулятора и только в течение определенного 
периода времени.

▸ Произойдет проверка информации, после чего пользователь получит ключ авторизации 
от сервисного представителя.

3. В меню menu bar, выбрать Device -> Access Control -> Set reset all PINs authorization key для 
открытия окна с таким же именем.

4. Ввести полученный ключ авторизации в поле ввода.

5. Подтвердить ввод при помощи OK.
▸ Если ввод был сделан правильно, все ПИНы будет установлены по умолчанию на 0000.
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8.8  Выбор типа устройства

8.9  Открытие существующего файла настроек
Нажать на иконку для открытия существующего файла настроек.

8.10  Настройки
Окно открывается после выбора устройства для введения новых настроек, или существующих 
настроек, или при загрузке таковых с устройства. Возможно внесение изменений в настройки 
путем выбора ввода в меню навигации (navigation bar). Соответствующие данные конфигурации 
отображаются в разделе настроек, там и происходит их обработка. В следующих 
разделах приводится описание настроек и регулировок, которые могут применяться в различных 
областях.

Нажать на иконку для запуска новой настройки и выбрать VariStep VariFuel2 как 
новый тип устройства.
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8.10.1 Внешнее устройство (External Device)

Для изменения типа VariFuel2, необходим доступ к уровню Advanced Service.

VariFuel2 
При помощи выпадающего списка выбрать тип VariFuel2, который соответствует устройству, 
где будут введены настройки. Проверить версию шагового двигателя после завершения 
выбора.

Примечания по версии шагового двигателя

Версия шагового двигателя указана на шильде газового двигателя на
VariFuel2.

Шаговые двигатели VariFuel2, версии которых не указаны на шильде или 
которые поставлены без шильд, являются версией А. Для версии А, выбрать 
вход в тип VariFuel2 без указания версии под Внешним устройством (External 
Device) (пример, VF2 200-120 для типа VariFuel2 200-120 с шаговым двигателем 
версии А).

Если нет типов VariFuel2, которые соответствуют версиям шагового двигателя, 
отображаемых под External Device, то база данных VariFuel MICT не обновлена. 
В этом случае, осуществить обновление он-лайн. Для получения дополнительной 
информации, см. раздел Обновление настроек он-лайн на странице 41.
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Изменение типа VariFuel2 
Действие:
Была произведена замена газового смесителя VariFuel2 на другой тип
VariFuel2.

Проблема:  

Решение: 
Выполнение следующих действий поможет решить проблему: 

1. Отключить первый VariFuel2 от блока управления.

2. Подключить MICT к блоку управления.

▸ Неверное подключение к шаговому двигателю приведет к
возникновению рабочих ошибок устройства.

3. Переключить на ручной режим. 

4. Подтвердить ошибки через MICT (Device -> Error Acknowledge). 
5. Изменить настройки нового типа VariFuel2.

6. Загрузить измененные настройки на устройство.

7. Отключить блок управления от питания.

8. Подключить новый VariFuel2 к блоку управления.

9. Подключить блок управления к подаче питания.

▸ Произойдет установка нулевой точки. Новое устройство VariFuel2
готово к эксплуатации.

  

При подключении нового VariFuel2, блок управления осуществляет 
установку нулевой точки. Тем не менее,  пока настройки содержат данные 
от первого устройства VariFuel, возможно, что VariFuel2 выйдет за диапазон 
перемещения, что приведет к механическим повреждениям, или появится 
необходимость перенастройки VariFuel2.
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8.10.2 Входы/Выходы - Настройка управления

Настройки страницы конфигурации зависят от входов и выходов, используемых на основном 
управлении. В этом случае, необходимо просмотреть информацию, приведенную в 
соответствующей документации блоков управления. Для внесения изменений, необходим 
доступ к уровню Advanced Service.

Выбор 
– Input 

Выбрать вход, который используется подключенным основным управлением для 
настройки топливного отверстия.

– Output 
Выбрать аналоговый (analog) выход, который используется подключенным основным 
управлением.

– External manual/automatic selection enabled 
Выключение диалогового окна для выключения переключения Auto/Manual на блоке 
управления. Блок управления может использоваться только в ручном режиме через 
систему MICT и с получением соответствующего доступа.
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Input Voltage/Input Current
В зависимости от выбранного входа, доступны разные опции настройки. Для аналоговых 
входов, необходимо ввести значения для открытого и закрытого положения топливного кольца. 
Необходимо соблюдать следующие значения:

– Входное напряжение: от 0 до 10 В

– Входной ток: от 0 до 20 мA

Input Step Count/Step Count Configuration 
Установить Direction (направление) и Init Position(начальное положение) шагов. Начальное 
положение (=Init Position) будет достигаться после установки нулевой точки шагового 
двигателя.

Для введения таких настроек, необходимо просмотреть дополнительную информацию, 
предоставленную в примечании.

Нажать на кнопку для применения настроек аналогового входа (тока или напряжения) для 
выбранного выхода. При выборе другого входа как выхода (пр., вход: ток; выход: напряжение), 
настроенные параметры конвертируются согласно диапазону значения выхода.  

Output Voltage/Output Current
В зависимости от соответствующего выбора, ввести соответствующие параметры напряжения 
или тока, которые соответствуют открытому и закрытому положению топливного кольца. Здесь
применяются те же диапазоны значений как и для аналоговых входов.
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Настройки выбранного входа
Аналоговые входы (ток или напряжение)

Пример: 

Цифровые входы
В системе MICT, возможно определить поведение цифровых входов DIRin и
STEPSin. Уровень на DIRin определяет направление, в котором движется
топливное кольцо при наличии импульсных сигналов на STEPSin. 
Пример: 

     

Неиспользуемые входы и выходы

  

Основанные на параметрах, использованных главным управлением, возможно 
определение параметров открытого и закрытого положения аналоговых входов 
в системе MICT. Параметры, применяемые ко входу будут конвертированы 
согласно углу открытия топливного кольца пропорционально введенным 
параметрам.

Главное управление работает со входом мощности от 4 до 20мА. В системе 
MICT, установить 4 мА для закрытого положения и 20мА для открытого 
положения. Если ток на входе составляет 16 мА, топливное кольцо будет 
открыто на 75%.

Выбрать функцию High -> Open в системе MICT под Direction. Если на DIRin
присутствует высокий уровень, к положению тока добавляется один шаг с 
каждым полученным сигналом импульса на STEPSin. Топливное кольцо 
постепенно движется от закрытого положения к открытому.

Следует заметить, что клеммы для аналоговых входов и выходов не 
выбранные в системе MICT, должны остаться свободными.



Ред. 07/2013 51 

8.10.3 Значения положения

Position 1/Position 2 
Значение двух настраиваемых положений (position1 и position2) вводятся в поле. Для ввода 
необходим доступ к уровню Service или Advanced Service. Следует указать необходимый угол 
открытия топливного кольца в процентах (100% - открытие, 0% - закрытие). Отверстия, 
указанные здесь, настраиваются при помощи MICT или цифровых входов блока управления.

Для получения дополнительной информации, см. раздел Настраиваемые углы открытия
(Position 1 и 2) на странице 32.
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8.10.4 Прочее – Связь (Miscellaneous - Communication)

Два интерфейса не доступны в настоящий момент.

Интерфейсы CAN и Modbus не могут быть активированы одновременно.

CAN
Нажатие на поле CAN enabled включит или выключит интерфейс шины CAN на устройстве.

– ALL-IN-ONE (J1939)/CANopen
Выбрать необходимый протокол, в зависимости от связи для ALL-IN-ONE или другого 
главного управления.

– Baudrate
Выбрать необходимую скорость передачи данных из списка. Используя протокол ALL-IN-
ONE (J1939), выбрать между 250 kBit/s и 500 kBit/s. Используя протокол CANopen,
скорость передачи данных настраивается между 10 kBit/s и 1 MBit/s. Для обоих
протоколов, рекомендованное значение составляет 250 kBit/s.

– Source Addr/CAN Node ID
Используя протокол ALL-IN-ONE (J1939), адрес источника распределяется между 0 и 255.
Используя протокол CANopen, идентификатор узла CANopen может быть распределен
между 1 и 127. Стоит отметить, что распределение идентификаторов осуществляется
только один раз.
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Modbus 
Нажатие на поле Modbus enabled включает или выключает интерфейс Modbus на устройстве.

– ASCII/RTU 
Определить, будут ли данные передаваться в режиме ASCII или RTU. 

– none/even/odd 
Определить, будет ли использоваться равенство битов, и будет ли оно четным или нечетным.

– full/half 
Определить тип связи: полнодуплексная или полудуплексная.

– Baudrate 
Выбрать необходимую скорость передачи данных из списка. Скорость передачи данных по 
Modbus может настраиваться между 1200 и 500000 BPS, рекомендованное значение 
составляет 19200 BPS. 

– Modbus Addr 
Адрес Modbus распределяется между 1 и 247. Следует отметить, что идентификатор 
может распределяться только один раз.

  
Настройка скорости передачи данных

  

Стоит отметить, что на всех устройствах, подключенные к шине, 
настраивается одинаковая скорость передачи данных.
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8.10.5 Прочее – Обращение в отдел Обслуживания (Miscellaneous - Service 
Contact)
Данная страница конфигураций может быть просмотрена всеми пользователями, но замены 
могут осуществляться только пользователем с уровнем доступа  Service.

Service Contact 
В данной области, возможно сохранение индивидуальных контактных данных.
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8.11  Runtime Data
Нажать на иконку для открытия окна Runtime Data. В следующих разделах находится обзор 
данных, которые просматриваются индивидуально.

Значок Функция 

Печать данных рабочего времени.

Печать данных в PDF файл.

Открытие предварительного просмотра для печати.

Запуск записи данных рабочего времени.

Останов записи данных рабочего времени.

Возможно осуществить печать и запись данных рабочего времени. Для этого, в окне меню
toolbar расположены следующие функции: 
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8.11.1 Runtime Data – Обзор (Overview)

В данном окне указывается следующая информация:

Reference Run 
На дисплее состояния отображается информация по нулевой точке:

– Зеленый: Нулевая точка была успешно установлена.

– Желтый: Процесс установки нулевой точки.

– Красный: Ошибки, произошедшие во время установки нулевой точки. Точка не найдена.

Manual/Auto 

На дисплее состояния отображаются выбранные режимы работы:

– Зеленый: Режим работы установлен

– Желтый: Производится команда в выбранном режиме работы. В автоматическом 
режиме работы, дисплей состояния загорится желтым, при приближении к положению 1 
и 2.

– Красный: Ошибка, произошедшая в выбранном режиме работы.
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Stepper Motor
На дисплее состояния отображается состояние шагового двигателя:

– Зеленый: Шаговый двигатель готов к работе.

– Желтый: Шаговый двигатель активен.

– Красный: Произошла ошибка.

Warning/Error
Красный дисплей состояния указывает на возникшую ошибку или предупреждающее 
сообщение. Дисплей пропадет после подтверждения ошибки при помощи программы MICT
(Device -> Error Acknowledge). Для получения дальнейшей информации, см. разделы Runtime 
Data – Неисправности на странице 59 и Runtime Data – Предупреждения на странице 58.

Opening
– Target 

Значение вводится для платы шагового двигателя в автоматическом режиме главным 
управлением или в ручном режиме при помощи системы MICT или кнопок Open/Close на 
устройстве.

– Actual 
Отображаемое значение означает размер отверстия топливного кольца в процентах.
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8.11.2 Runtime Data – Предупреждения (Warnings)

Предоставляется следующая информация: 

– Time Stamp 
Статус счетчика моточасов, за которые произошла неисправность.

– Warning Id 
Идентификатор предупреждений используется для определения предупреждения

– Warning 
Краткое описание предупреждения. Возможно появление следующего предупреждения:

Предупреждение Описание 

Cpu Usage Нагрузка ЦПУ превышает 80%.
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Существуют следующие опции: 

– Update 
При помощи кнопки Update, возможно ручное обновление отображаемого списка 
предупреждений. При появлении предупреждения, список обновляется автоматически.  

– Show in reverse order 
Активировать диалоговое окно для отображения перечисленных входов в обратном 
порядке.

– Show only current entries 
Активировать диалоговое окно только для отображения обновленных входов.

Предоставляется следующая информация: 

– Time Stamp 
Состояние счетчика моточасов, за которые произошла ошибка. 

– Error Id 
Идентификатор ошибки используется для выявления ошибки.

8.11.3 Runtime Data – Неисправности (Errors) 
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– Error 
Краткое описание неисправности. Возможно наличие следующих ошибок:

Ошибки Описание 

Interframe Step Loss Потеря шагов из-за неровного хода газового смесителя.
Решение: 
Проверить плавность работы газового смесителя и высокое
натяжение ремня.

Stop Step Loss Потеря шагов из-за неровного хода газового смесителя.
Решение: 
Проверить плавность работы газового смесителя и высокое
натяжение ремня.

Timeout 

Shut Off Устройство было выключено.

Low Power IRQ Кратковременное падение напряжения.

Решение: 
Улучшить подачу напряжения.

Etpu Handler Msg Queue 
Full 

Программное обеспечение перегружено. Обратиться в службу
технической поддержки.

Input Handler Msg Queue 
Full 

Программное обеспечение перегружено. Обратиться в службу
технической поддержки.

Output Handler Msg
Queue Full 

Программное обеспечение перегружено. Обратиться в службу
технической поддержки.

Over Temperature IRQ Превышение температуры.

Решение: 
Улучшить охлаждение.

Over Current IRQ Ток шагового двигателя слишком велик

Решение: 
Проверить обмотку шагового двигателя.

Доступны следующие опции:

– Update 
При помощи кнопки Update, возможно вручную обновить список отображаемых ошибок.
При возникновении ошибки, список обновляется автоматически.

– Show in reverse order 
Активировать диалоговое окно для отображения перечисленных входов в обратном порядке.

Соответствующее действие не может быть завершено в рамках
определенного времени.

Обратиться в службу технической поддержки вкл. полное
сообщение о неисправности.
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– Show only current entries 
Активировать диалоговое окно только для отображения входов, которые являются 
обновленными.

8.11.4 Runtime Data – Диагностика (Diagnostics)

На этом экране, возможно получение следующей информации:

Operation Mode
В разделе режимов работы отображается, какой рабочий режим (Manual или Automatic
Operation Mode) активен на данный момент, а также параметры настройки режима 
работы. Таким образом, существует две опции:

– Ctrl
Показывает, если рабочий режим был настроен при помощи программы MICT или 
переключения Auto/Manual на устройстве (аппаратное обеспечение).

– Mode
Отображение текущего рабочего состояния.
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States
В данном разделе представлена информация по текущим условиям блока управления, шагового 
двигателя и всех индивидуальных фаз нулевой точки.

CPU Load
Использование силы тока процессора.

Supply Voltage
Текущее напряжение блока управления.

Current Temp
Текущая температура на щите.

Max Temp
Максимально допустимая температура щита с момента последнего включения блока управления.

Min Temp
Минимально допустимая температура щита с момента последнего включения блока управления.

Max Step Loss
Внутренние параметры диагностики, связанные с управлением шагового двигателя. Если 
потеря шагов слишком велика, это приведет к появлению сообщения о неисправности.
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8.11.5 Runtime Data – Информация (Information) 

На данной странице, можно просмотреть информацию об устройстве и данные версии. 
Возможна также печать текущий данных по рабочему времени или, в случае возникновения 
неисправности, их отправка в Отдел Сервиса MOTORTECH по факсу или в виде файла PDF по 
электронной почте. Для осуществления быстрого обслуживания, Компания в кратчайший срок 
получает всю необходимую информацию.



8 НАСТРОЙКИ ЧЕРЕЗ СИСТЕМУ MICT 

64 Ред. 07/2013 

8.12  Log 
Нажать на иконку для открытия окна Log. Данное окно доступно только для 
пользователей с допуском к запуску при уровне доступа Advanced Service. 

Окно Log служит поддержкой диагностики неисправностей для MOTORTECH.

– Automatic scrolling
Если функция активна, панель обзора фокусируется на самом последнем сообщении.

– Log level
Выбор уровня log будет уточняться согласно требованию MOTORTECH.

– Write log to file
Данное диалоговое окно активируется или выключается соответственно для сохранения введенных 
данных в выбранном файле. Если функция выключена, то данные просто отображаются на 
дисплее.

– Select file
При помощи данной кнопки, возможен выбор файла, для которого необходимо сохранить 
введенные данные.



Ред. 07/2013 65 

При необходимости создания журнала регистрации (log) в случае запроса для проведения 
сервиса, выполнить следующее:

1. Открыть окно Log через меню toolbar или через меню menu bar.

2. Выбрать путь при помощи кнопки выбора файла и ввода названия файла для log.

▸ Если файл не существует, он автоматически создаст расширение .log. 

3. Активировать диалоговое окно Write log to file. 

4. Выбрать уровень, указанный MOTORTECH из списка Log level .
5. Оставить окно открытым. 

▸ Сообщения log вводятся как в окно, так и в выбранный файл.
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9.1  Обновление программного обеспечения
При помощи программы MOTORTECH Flash Tool, возможно осуществление обновления программного 
обеспечения для блока управления. Данная программа содержится на поставленном диске.

Установка MOTORTECH Flash Tool
Процесс установки программного обеспечения MOTORTECH Flash Tool:

1. Запуск установки.

– Вставить CD-ROM в оптический привод CD/DVD используемого ПК. Если функция 
автозапуска включена, отключить программу по установке для MOTORTECH Integrated 
Configuration Tool.

– Скопировать файл MOTORTECHFlashTool-x.x.x.zip (пр. MOTORTECHFlashTool-0.8.3.zip) 
на используемый ПК.

– Распаковать файл.

– Начать процесс установки, путем запуска файла setup.exe.

2. Установка программы.
Следовать инструкциям по установке. Необходимо отметить, что условия соглашения по 
лицензии должны быть приняты до использования программы MOTORTECH Flash Tool. 
Установка невозможна без принятия условий соглашения.

3. Если процесс еще не закончен, установить драйвер USB путем запуска файла
CDMxxxxx_Setup.exe (пр. CDM20824_Setup.exe) с диска CD-ROM.
▸ Теперь программа MOTORTECH Flash Tool установлена. Возможно подключение ПК к 

блоку управления через интерфейс USB.

9 ЭКСПЛУАТАЦИЯ
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Menu Bar и Toolbar
После запуска программы MOTORTECH Flash Tool, следующие инструкции доступны при 
нажатии на иконки в toolbar и при входе в меню menu bar: 

Значок Меню Функция 

File -> Open Открыть файл программного обеспечения.

File -> Quit Выход из программы.

View -> Extended file information 
view 

View -> Extended connection 
settings 

Показать/скрыть  дополнительную 
информацию и настройки подключения к 
устройству.

View -> Reload file 

Device -> Search devices Перезапуск поиска для подключения 
устройства.

Device -> Flash device 

Settings-> Language Открыть окно Select Language для 
изменения языка интерфейса программы.

Help -> Help Открыть функцию он-лайн помощи.

Help -> About MOTORTECH Flash 
Tool  

Открыть подробную информацию по 
программе.

Показать/скрыть дополнительную 
информацию по файлу ПО.

Снова загрузить информацию по выбранному 
файлу программного обеспечения.

Запуск процесса обновления или процесса 
снижения значения.
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Запуск обновления программного обеспечения
Для запуска обновления ПО, действовать следующим образом:

1. Если система MICT подключена к блоку управления, необходимо отключить соединение.

2. Запустить программу MOTORTECH Flash Tool через Start -> Programs -> MOTORTECH -> 
MOTORTECH Flash Tool -> x.x.x (e. g. 0.8.3) -> MOTORTECH Flash Tool.
▸ Теперь программа MOTORTECH Flash Tool запущена. 

▸ ПО автоматически проверяет все порты для подключенных устройств.

3. В разделе Status под Device, проверить, чтобы устройство было правильно распознано. 

▸ Если система MOTORTECH Flash Tool не распознает устройство, подключенное к ПК 
по интерфейсу USB, возможно обновление программного обеспечения. Для этого, 
соблюдать инструкции в окнах информации MOTORTECH Flash Tool для следующих 
шагов.

4. В области File, выбрать необходимый файл обновления при помощи кнопки Select.
5. При чтении отображаемой информации по файлу, убедиться, что файл обновления 

подходит для используемого устройства.

6. Запустить процесс  обновления при помощи кнопки Flash, или используя меню или
toolbar. 
▸ Блок управления перезапустится автоматически.

▸ Открывается информационное окно, в котором указана текущая используемая версия 
ПО на блоке управления, а также соответствующая версия обновления.

7. Для подтверждения выбрать Yes для продолжения процесса обновления.

▸ Теперь произойдет запуск обновления. 

▸ При успешном обновлении ПО, появится соответствующее сообщение.

▸ Теперь, блок управления произведет установку нулевой точки.

8. После успешного обновления ПО, проверить все данные настроек.

Уровень доступа для обновления программного обеспечения

   

Процесс занижения

Процесс для снижения значения в основном схож с процессом обновления. 
Пользователь будет информирован, что новое ПО было установлено на 
устройстве.

   

Если был произведен запуск управления доступа для устройства, 
необходимо ввести ПИН уровня Master для обновления ПО. Для получения 
более подробной информации, см. раздел Управление доступом блока
управления на странице 42.
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Помощь с проблемами подключения

Если правильно подключенное устройство не может быть найдено в 
процессе автоматического поиска, то возможной причиной может стать, 
например, слишком большого количества распределенных интерфейсов 
связи, что необходимо проверить. В этом случае, из выпадающего списка
Port в области Connection выбирается и настраивается интерфейс.
Если предназначенный порт еще не отображен в списке или если проблема 
не устранена, поможет настройка времени задержки для подключения. 
Настройки задержки отображаются на главной странице путем ввода в 
menu bar: View -> Extended connection settings.
Ввести следующие настройки: 

– Update Request Timeout 

– Start Timeout 

  

Диапазон настройки: от 1000 мс до 10000 мс, значение по умолчанию: 
3000 мс. Расширение задержки может быть преимуществом, особенно 
при проблемах подключения, которые происходят из-за большого 
количества распределенных портов компьютера.

Диапазон настройки: от 1000 мс до 10000 мс, значение по умолчанию: 
3000 мс. Изменение задержки может быть преимуществом, особенно 
при проблемах подключения, которые происходят из-за прерывания 
связи между компьютером и устройством.
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10.1  Неисправности 
Если происходит обнаружения неисправности шагового двигателя, светодиод status будет
мигать красным. При работе в автоматическом режиме, цифровой выход ERRORout также
активируется и загорается соответствующий светодиод. При помощи программы MICT,
возможно увидеть тип произошедшей ошибки. Для получения дальнейшей информации,
необходимо обратиться к разделу Runtime Data – Ошибки на странице 59. 

10.2  Возможные ошибки 
Низкое напряжение 
Напряжение упало ниже 11 В. 

Возможные причины: 

– Недостаточное питание.

– Аккумулятор изношен.

– Неисправность проводов питания.

– Провода для питания проложены неверно.

Потеря шагов   
Шаги, предписанные блоком управления были выполнены шаговым двигателем.

Возможные причины: 

– Слишком высокое напряжение ремня.

– Залипание топливного кольца (пр., из-за отложений).

– Провода к шаговому двигателю неисправны или неверно подключены.

– Шаговый двигатель неисправен.

Превышение температуры
Превышение температуры щита блока управления.

Возможные причины: 

– Слишком высокая температура окружающего воздуха.

– Недостаточная циркуляция воздуха около устройства.

Пробный запуск не удался
Невозможно определить исходную точку шагового двигателя.

Возможные причины: 

– Слишком высокое натяжение клинового ремня.

– Залипание топливного кольца (пр., из-за отложений).

– Провода к шаговому двигателю неисправны или неверно подключены.

– Шаговый двигатель неисправен.

10 НЕИСПРАВНОСТИ
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Превышение значений тока
Ток шагового двигателя слишком высок.

Возможные причины:

– Провода к шаговому двигателю неисправны или неверно подключены.

– Шаговый двигатель неисправен.

– Плата шагового двигателя неисправна.

10.3  Подтверждение неисправностей
В ручном режиме, возможны следующие опции для подтверждения рабочих ошибок:  

– При помощи функции Error Acknowledge в системе MICT. 

– При одновременном нажатии на кнопки Open и Close. 

В автоматическом режиме, возможны следующие опции для подтверждения рабочих тревог:  

– Главное управление отправляет сигнал на цифровой вход сброса.

– При одновременном нажатии на кнопки Open и Close. 
– При помощи функции Error Acknowledge в системе MICT.

Подтверждение неисправности в автоматическом режиме работы

  

10.4  Информация по обслуживанию клиентов
Связаться с Отделом сервиса возможно в течение рабочего времени по следующим
телефонам и факсу или по электронной почте: 
Tel. +49 5141 9399 0 

Fax +49 5141 9399 99 

E-mail service@motortech.de 

Если блок управления находится в автоматическом режиме, и неисправность
снова должна произойти после подтверждения ошибки через систему
MICT, переключить блок в ручной режим до повторного подтверждения
неисправности. После подтверждения неисправности, возможно исправление
неверной конфигурации и передача на устройство посредством загрузки.
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10.5  Возврат оборудования на проведение ремонта/проверки
Для возврата оборудования на проведения ремонта и осмотра, необходимо получить 
форму возврата и номер возврата от MOTORTECH. 

Полностью заполнить форму. Только полностью заполненная форма возврата гарантирует 
быструю обработку запроса на ремонт.

Отправить устройство и форму возврата на один из адресов представительств MOTORTECH, 
указанных ниже: 

  
MOTORTECH GmbH 
Hogrevestrasse 21–23
29223 Celle 

Germany 

Tel. +49 51 41 - 93 99 0 
Fax +49 51 41 - 93 99 98 

www.motortech.de 
info@motortech.de 

МОТОРТЕХ Россия
пр. Маршала Говорова, 35, к.5
198095 Санкт-Петербург
Россия

Tel. +7 812 920 1387  

www.motortech.ru 
info@motortech.ru 

10.6  Инструкции по упаковке оборудования
При обратной отправке, оборудование должно быть упаковано следующим образом: 

– Использовать упаковочный материал, который не повредит поверхность оборудования.

– Обернуть оборудование в прочный материал и закрепить внутри упаковки.

– Использовать прочную клейкую пленку для герметизации упаковки.

– Плата шагового двигателя должна быть упакована в защитную фольгу ESD.
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11.1  Запасные части и дополнительное оборудование 
Для получения информации по ЗИП и дополнительному оборудованию см. текущий буклет по 
продукции, который доступен для скачивания с сайта Интернет www.motortech.de. 

11 ТЕХНИЧЕСКОЕ ОБСЛУЖИВАНИЕ
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Мы совершенствуем газовые двигатели 
Оригинальные запчасти MOTORTECH для стационарных газовых
двигателей 

Как поставщик, MOTORTECH разрабатывает, производит и распространяет
дополнительное оборудование и ЗИП, а также быстроизнашивающиеся
детали для всех видов газовых двигателей во всем мире: системы зажигания
и мониторинга, промышленные свечи зажигания и кабели высокого
напряжения, системы соединений и газовые контроллеры - от детонации
до регулятора частоты вращения и полной системы управления газовым
двигателем. Он-лайн поддержка и специальные учебные курсы дополняют
спектр наших услуг.


